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Procedure for General Use of the XPS
Loading a sample into the XPS: 

1) Fill out the XPS log book on the computer desk.  Make a note of the pressure readings of IG1 and IG2 on the valve control panel over the XPS, the time you sign in, and your sample material. Unusually high pressures (ca. IG1 > 10-7 or IG2 > 10-8  Torr) could indicate a problem with the instrument and should be brought to the attention of a GLA. 
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Check the control panel to make sure that all gates are closed EXCEPT gates 2 (load lock/turbo), 6 (XPS/cryo), and possibly gate 1.  Gates 2 and 6 should remain open (lights on) and the XPS stage (control 7) can be up (light on) or down.  Note that gate 0, for the load lock cryo pump, should also be open. The switch for gate 0 is attached to the left side of the XPS table. 
3) Read the pressure in the back chamber above the turbo by looking at the pressure gauge sitting above  above the control panel for the gates.  When the load lock is pumped down, the pressure will read ≈ 10-4 (the lowest the capacitance gauge reads) or 0 Torr.  The actual pressure in the load lock, if it is below 10—5 Torr, is observable on the left ion gauge above the control panel.  

4) Check that no samples are in the instrument in either the analysis chamber or the load lock.  If there is a stub already in the instrument, you will need to unload it before you can load your own stub.  Do so by following the unloading procedure, starting on page 7.

5) Mount your sample on the XPS stub.  
a) Public use stubs should be in glass jars on the counter.  Stubs should be handled only while wearing gloves, and should be stored in a clean, sealed container.  Please do not remove stubs from the XPS room.  
b) Wipe the stub with a Kimwipe moistened with isopropanol before use.  
c) Use the screws on the stub to mount your sample securely. If you must use carbon tape (only UHV carbon tape is allowed) use only a very small amount and do not load more than 3 samples with carbon tape at one time. The screws are preferable; so only use carbon tape if absolutely necessary.

d) Samples should not extend past the edges of the stub.
6) To bring the load lock up to atmospheric pressure: 
a) If gate 1 is closed, open it now.
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Turn off IG1.

c) Close gate 0 to the load lock cryo pump, (switch left side of XPS table).

d) Turn off the load lock turbo (Pfieffer) pump by pressing the “ON/OFF” button on the Pfieffer controller to the left of the valve control panel.  The mechanical vacuum pump on the floor will turn off automatically. 
e) Close gate 2 (load lock/turbo) and wait until you hear the gate click shut. 

f) Once gate 2 is closed, open gate 3 (load lock N2).  The pressure in the load lock will increase as N2 fills the chamber.  When the pressure reads approximately 720 Torr, the door to the load lock should open. To easily remember these steps think “0,off,2,3,”.
7) Place the stub onto the load lock arm. The stub has a freely rotating spindle below a short, cylindrical collar (see image on page).  The bottom notch of the spindle should fit snugly into the arm.  Rotate the magnet on the arm to lock the stub in place.  Close the load lock door.

8) Check that the turbo is stopped.  If it is not, wait until it reads 0 Hz.  The speed of the turbo is shown on the turbo controller. It takes about 5 minutes for the turbo pump to stop spinning.

9) Close gate 3 (load lock N2) and open gate 2 (load lock/turbo).  While holding the door closed, turn on the turbo pump by pressing the "On/Off" button on the right side of the “Load Lock Turbo” control panel (3,2,on). Watch the pressure in the back chamber; it should decrease continuously to the low 10-3 Torr range. The turbo pump occasionally will hang at a pressure, if this persists for 30 seconds or more, turn off the turbo pump, wait for it to spin down, and restart it. 
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After a few minutes, the turbo pump should reach maximum speed (1500 Hz) and stabilize in power (0-7W).

11) When the pressure reaches < 1 x 10-4 Torr, you can turn on IG1.  If the pressure is in the 10-5 Torr range, open the gate 0 to the load lock cryo and close gate 1.  At this point it is acceptable to leave the lab as the samples should remain under the cryo pump vacuum for a minimum of 30 minutes (usually closer to 60 minutes).   If the pressure is decreasing very slowly or your sample is outgassing, you may want to leave gate 1 open for the first 30-60 minutes of pumping to increase pumping capacity.

Moving a sample into the XPS chamber: 

1. After 30 minutes check the pressure in the load lock.  It should read < 5×10-8 Torr.  If not wait longer. 

2. Check that switch 7 (XPS stage) is down (light is off). 

3. Open gate 5 (to XPS chamber).  This gate may take 10 s to fully open. Switch on the light in the analysis chamber. 
4. Use the transfer arm to move the stub into the analysis chamber, stopping the magnet of the transfer arm at the beginning of the ‘CAUTION” region on the arm (about a foot from the end of the table). 
5. To mount the stub on the stage, the stage must be lowered from the data acquisition height. Check that the slot on the sample stage aligns with the stub. Move the sample stage by using the stage joystick to align the shaft of the stub and the sample stage.  Moving the joystick in the x and y directions will move the stage in the same direction. The top of the stage should be aligned with the bottom edge of the top collar of the stub (see figure on page 7); if not, please contact a GLA.  Move the transfer arm slowly when placing the stub on the stage.  The stub is fully on the stage when the collar above the stub spindle completely overlaps the semicircular wear mark on the stage.  
6. Unlock the stub from the transfer arm.  
7. While watching the stub on the sample stage, withdraw the transfer arm.  If the stub starts to move push it back onto the stage and try again.  If you cannot get the stub to stay on the stage call a GLA.

8. Move the transfer arm back to the load lock chamber, and close gate 5 (to XPS chamber).
9. Raise switch 7.  This lifts the stage into the appropriate position to collect data.  If the gears on the stage and the stub do not mesh, try rotating the joystick.
Collecting XP spectra: 

1. The computer should be on.  If not, the computer is located at the back right side of the instrument, behind the analysis chamber. Log in using the ID and password posted on the monitor.  If the computer is restarted you will need to reengage the joystick controls.  To do this, first click on the snoopy icon in the taskbar. Then, start the “ESCA Capture” program and go to View=>Motion Control Pnl.  If the button labeled “Joystick” is red, click on it and it should turn green. 
2. Turn on the desk lamp.

3. If it is not already open, open MicroViewer 5MP camera software. Note the camera is upside down. Position the window so that the center of the small crosshair icon at the top of the window lines up with the upper black cross on the right monitor.  This ensures that the lower cross near the center of the screen reflects where the X-rays will hit the sample. Do not right click within the camera window, doing so will move the program’s crosshairs. If the program crosshair does not align with the lower black cross in the center of the monitor right click on the screen to move the crosshair to that position.
4. Make sure that the 9600 (on the electronics rack) has the button for computer lit (push the button if it is off).

5. Open your personal database in ESCA Capture.  You may have to go to View=>ESCA Control Pnl and check the ‘Xray Gun Operate’ box to turn on the high voltage to the gun by switching the gun controller from standby to operate.  

6. To find the correct z position for the sample, in the ESCA Control Panel set “CBE” to an energy for an element in your sample. A CBE of 285 for C 1s or 533 for O 1s should be suitable for most samples. Select a spot size of 800, a Res# of 4, and a “Cap” value of 5:00. If the box that should say “Cap” reads “Avg”, it can be switched back to “Cap” by clicking on it. The “Scans” box should be unchecked.

7. Verify that the pressure read by IG2 is < 2 x 10-8. Move the sample under the lower black cross on the screen. Click the Start box and adjust the z position of the sample until the count rate reads >500.  Flip the Auto Z switch to the right of the joystick from off to on. Watch the count rate increase. Wait at least 10 seconds. Make sure that your sample is still under the lower black cross. If it is not, navigate to the desired position on your sample. Once the count rate has stabilized, switch the Auto Z switch to off.  Once the sample is at the correct height, change the spot size to “Spot Off” and click Start. You can now close the ESCA Control Panel.
8. To collect a survey scan of the sample, make sure the “recipes” button is selected in the upper left-hand corner of the screen.  Select the project and recipe file that contains the appropriate scan parameters.  Recipe parameters are shown in the right-hand dialog box.  Along the far right-hand side of the box are buttons that add, delete, and move regions within a recipe.  Following are brief descriptions of some common region parameters that are used often:

A. Survey scan from 0-1000 BeV

i. Function: Survey

ii. LBE (low binding energy): 0

iii. Window width: 1000

iv. Spot size: 800

v. Scans: 2

vi. Res #: 4
vii. eV/step: 1

B. Detailed scan of the Si 2p peak

i. Functions: ResHi

ii. CBE (center binding energy): 101.5 

iii. Window width: 8

iv. Spot size: L2
v. Scans: 20

vi. Res #: 2

vii. eV/step: 0.065
C. Shut off x-rays after a set of scans (always add this step to the end of a recipe)
i. Function: Survey
ii. LBE (low binding energy): 0

iii. Window width: 1

iv. Spot size: off

v. Scans: 1

vi. Res #: 4

vii. eV/step: 1
Normally it is best that the resolution and spot size go together as shown in the table below:
	Spot Size
	Resolution

	800
	4

	500
	3

	300
	2

	100
	1

	L1 (100x400)
	1

	L2 (250x1000)
	2

	L3 (500x1200)
	3


9. The last region in every scan must have the “spot size” set to “Off.”  This is the only way to turn off the X-ray source.  

10. Save your recipe.  

11. You may use the autosampler function to analyze multiple samples without coming back to move the stage. Contact a GLA if you have not been trained on its operation.

12. In the lower right-hand region of the screen, name your project and experiment.  You can add a description of your experiment.  Avoid using parenthesis, colons, semicolons, dashes, or underscores in your file names. 

13. Make sure that the analysis chamber pressure is <2 x 10-8 and dropping. Do not commence your run if it is not. In the main program window choose the button labeled “Run” at the top of the screen. 

14. At the end of the scan, the file may be opened by selecting the “Experiment” button in the upper left-hand corner of the screen.  The data is saved automatically and will only be removed if you save over it; we recommend that you periodically backup your database/protocol to a thumb drive.  Data may be analyzed using a variety of techniques given in the data reduction program.  See the blue binder or a GLA for more information. 

15. Export data to an Excel or Vamas (CasaXPS) file.  This can be done either from either the ESCA Capture or ESCA Analysis program. Select which experiment to export, and then choose Export from the File menu.  Select “EXCEL” or VAMAS in the dialog box. Excel files will show every region of your scan in a different sheet of the workbook.  Save this to a disk.  You are responsible for exporting and saving your own data; the MMRC and the XPS GLA are not responsible for lost data.  
Procedure for aligning the camera crosshairs with the X-ray spot
1. Follow this procedure if you or someone accidentally right clicks in the camera software and moves the position of the crosshairs from the set location.

2. Close the MicroViewer 5MP camera software and reopen it from the desktop icon. This ensures the software window is sized correctly. Do not maximize the software.

3. Move the window to the right monitor and line up the crosshair icon in the top toolbar with the upper black cross on the monitor. In this position, with the window this size, the lower black cross on the screen marks the center of the X-ray spot. 

Right click in the camera software where the black cross is to realign the crosshairs with the lower black cross to mark the X-ray spot on the sample. 

4. Unloading the sample:
1. Lower switch 7 to lower the stage.

2. Check that the load lock is at low pressure < 5 x 10-8 Torr.

3. Open gate 5. 
4. Placing the stub on the transfer arm. Make sure the transfer arm fork is closed. Move the stage to align the stub with the transfer arm. The bottom of the transfer arm fork should be positioned slightly higher then the top of the bottom collar of the stub (see figure below).  Push the transfer arm fork onto the stub. Turn the magnet 180( to lock the stub on the transfer arm.

5. Retract the transfer arm into the load lock and close gate 5 (to XPS chamber).

6. Open gate 1 (load lock/back chamber), close gate 0 (load lock cryo pump), and turn off IG1.

7. Turn off turbo, close gate 2, and open gate 3 to let N2 into the load lock. 

8. When the pressure in the back chamber is ~ 760 the load lock door should open. 

9. Remove stub and wait for the turbo to stop spinning.

10. While holding the door closed, close gate 3, open gate 2, turn turbo on (3, 2, on).

11. Sign out in the logbook and note any problems or observations while using the instrument.
12.  When the turbo reaches full speed and the pressure is < 10-4 Torr, open gate 0 and close gate 1. Turn on IG1.
13. When you leave, the load lock should be under stable vacuum with the turbo pump at max speed, 
a. gates 2, 6 & 0 should be open and 
b. all others (1, 3, 4, 5) should be closed, and IG1 and IG2 should be reading normal low pressures  (mid 10-9 Torr or lower).
Send questions to 

Noah Plymale: nplymale@caltech.edu; x3964
Jonathan Thompson: jrthomps@caltech.edu; x3964
Annelise Thompson: athompso@caltech.edu; x3964
Loading Samples Summary


check no stub in XPS


open gate 1


turn off IG1


close gate 0


Pfeiffer (Turbo) off


close gate 2


open gate 3


load stub;


wait for Pfieffer to stop


hold door, close gate 3


open gate 2


Pfeiffer on


wait for back chamber   < 1 x 10-4 Torr


turn on IG1


open gate 0


close gate 1


wait >½ hour till IG1     < 5 x 10-8 Torr





Moving sample to XPS Stage


IG1 < 5(10-8


Lower Stage switch 7


Center stage in x and y


Open gate 5


Push sample with �transfer arm onto Stage


Unlock sample from arm


Withdraw arm to LL


 Close gate 5


Raise stage (switch 7)





Unloading Sample Summary


check IG1 < 5 x 10-8 Torr


lower stage (gate 7)


open gate 5


move stub from XPS stage to arm


move stub to load lock


close gate 5


open gate 1


close gate 0


turn off IG1


turn off Pfeiffer


close gate 2


open gate 3


remove sample


wait for Pfeiffer to stop


hold door, close gate 3


open gate 2


start Pfeiffer.


wait for P < 1x10-4 Torr


open gate 0


close gate 1,turn on IG1
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